


━━━━━━━━━━━━━━━━━━━━━━━━━━━━━━━━━━━━━━━━

Yapay Zekâ Uygulamaları Geliştirme Ve Uyum Eğitimi
1-4. Saat Ders Planı  |  Yapılandırmacı 5E Modeli

━━━━━━━━━━━━━━━━━━━━━━━━━━━━━━━━━━━━━━━━


	  Kurs
	

	  Modül / Saat
	[bookmark: _GoBack]  

	  Tarih
	  




	  PROGRAM  |  4 Saatlik Ders Programı



	Saat
	Konu
	Süre

	1. Saat
	Python 3 Kurulumu ve Calisma Ortami
	45 dk

	2. Saat
	PyCharm IDE Kurulumu ve Yapilandirmasi
	45 dk

	3. Saat
	Python Kutuphanelerinin Kurulumu (pip)
	45 dk

	4. Saat
	NumPy ile Dizi ve Matris Olusturma
	45 dk



	E1 Girme
	E2 Keşif
	E3 Açıklama
	E4 Derinleştirme
	E5 Değerlendirme




━━━  1. SAAT  ━━━
Python 3 Kurulumu ve Calisma Ortami

	  KAZANIMLAR  |  Öğrenme Kazanımları



Genel Kazanım: Isletim sistemine uygun Python 3 kurulumunu gerceklestirir ve calisma ortamini hazirlar.

	Kod
	Kazanım
	Bilişsel Düzey

	2.1.1
	Python 3 kurulum asamalarini siralar.
	Bilgi

	2.1.2
	Isletim sistemine uygun Python 3 kurulumunu yapar.
	Uygulama

	2.1.3
	Python komut satirinda temel komutlari calistirir.
	Uygulama



	  ÖN BİLGİ  |  Ön Bilgi ve Hazırlık



Ön Koşul Bilgiler: Temel bilgisayar kullanimi bilgisi.
  Öğrencinin Bilmesi Gerekenler
Python in bir programlama dili oldugunu.
Yapay zeka uygulamalarinda Python in yaygin kullanildigiini.
Isletim sistemi kavramini (Windows, Linux, macOS).
  Olası Kavram Yanılgıları
Python in sadece yapay zeka icin kullanildigii sanilmasi.
Python kurulumunun cok zor oldugu dusuncesi.
Her Python surumunun ayni oldugu yanilgisi.
  Hazırlık Materyalleri
Bilgisayar (Windows/Linux)
Internet baglantisi
Python 3 kurulum dosyasi
Projeksiyon
________________________________________________________________________________
	  E1  |  GİRME (ENGAGE)  —  Dikkat Çekme & Merak Uyandırma



  Süre: 5 dakika
Dikkat Çekici Soru: "Yapay zeka uygulamalari gelistirmek icin once bir dil ogrenmemiz lazim. Python, yapay zekanin lingua franca sidir!"
Günlük Hayat Bağlantısı: Yabanci bir ulkeye gitmeden once o ulkenin dilini ogrenmek gibi: Python, yapay zeka dunyasinin ortak dilidir.
  Ön Bilgi Yoklama Soruları
  1. Python nedir?
  2. Neden Python tercih ediliyor?
  3. Python 3 ile Python 2 farki nedir?
  Motivasyon Etkinliği: "Python Nerede Kullaniliyor?"
Açıklama: Python in kullanim alanlarini arastirma.
Yönerge: Egitmen Python ile yapilmis unlu projeleri (Instagram, YouTube, Netflix onerileri) gosterir. Ogrenciler Python in nerelerde kullanildigiini tartisir.
  Senaryo / Problem Durumu
	Bir sirket yapay zeka projesi baslatmak istiyor. Neden Python secmeli?



________________________________________________________________________________
	  E2  |  KEŞİF (EXPLORE)  —  Aktif Keşif & Deneyimleme



  Süre: 10 dakika
  Keşif Etkinliği: "Python 3 Kurulum Calismasi"
Türü: Bireysel Uygulamali Calisma
Amacı: Python 3 u isletim sistemine kurmak ve dogrulamak.
Malzemeler: Bilgisayar, internet baglantisi, Python 3 kurulum dosyasi
  Yönerge Adımları
  1. python.org adresinden Python 3 indirin.
  2. Kurulum sihirbazini baslatin (Add to PATH secenegini ISARETLE).
  3. Kurulumu tamamlayin.
  4. Komut satirinda 'python --version' yazarak dogrulayin.
  5. Python REPL de 'print(Merhaba Yapay Zeka!)' yazin.
Öğrenci Rolü: Yazilim muhendisi adayi: gelistirme ortamini hazirlayan
Öğretmen Rolü: Kurulum adimlarini izler ve sorunlari giderir
Beklenen Ürün: Python 3 Kurulmus Bilgisayar
  Araştırma Soruları
  1. Python hangi yil ve kim tarafindan gelistirildi?
  2. Python 3.x surumleri arasindaki farklar nelerdir?
  3. Anaconda dagitimi nedir ve ne avantaj saglar?
Grupla Çalışma Kuralları: Add to PATH secenegi MUTLAKA isaretlenmeli! Aksi halde komut satirindan erisim sorunlu olur.
________________________________________________________________________________


	  E3  |  AÇIKLAMA (EXPLAIN)  —  Kavramları Yapılandırma



  Süre: 12 dakika
  Temel Kavramlar
	Kavram
	Tanım
	Örnek
	Görsel Açıklama

	Python
	Yuksek seviyeli, genel amacli programlama dili
	Kolay sozdizimi, genis kutuphane destegi, topluluk
	Python logosu

	Python 3
	Python in guncel ve desteklenen surumu
	Python 2 desteigi bitmistir, Python 3 kullanilmali
	Surum karsilastirmasi

	REPL
	Read-Eval-Print Loop: interaktif Python kabuugu
	Komut satirinda python yazarak acilir
	REPL ekran goruntusu

	PATH
	Isletim sisteminin program arama yolu
	Python un her yerden calistirilabilmesi icin gerekli
	PATH ayari gorseli

	pip
	Python paket yoneticisi
	Kutuphaneleri indirip kurmak icin kullanilir
	pip install ornegi



  Konu Anlatımı
Python, 1991 yilinda Guido van Rossum tarafindan gelistirilen, okunakli sozdizimi ve genis kutuphane ekosistemi ile bilinen bir programlama dilidir. Yapay zeka, veri bilimi, web gelistirme ve otomasyon gibi pek cok alanda kullanilir.
Python 3, Python in aktif olarak gelistirilen ve desteklenen surumudur. Python 2 nin destegi 2020 de sona ermistir. Yeni projeler MUTLAKA Python 3 ile baslatilmalidir.
Kurulum sirasinda 'Add Python to PATH' secenegi isaretlenmezse, Python komut satirindan dogrudan calismaz ve her seferinde tam yol yazmak gerekir. Bu en sik yapilan kurulum hatasidir.
  Somut Örnekler
	Örnek
	Açıklama
	Günlük Hayat Bağlantısı

	Kurulum
	python.org dan Python 3.11 indirme
	Windows kurulumu

	Dogrulama
	python --version -> Python 3.11.x
	Basarili kurulum

	REPL
	>>> 2+2 -> 4
	Interaktif hesaplama

	print
	print('Merhaba') -> Merhaba
	Ilk Python komutu



  Görseller ve Tablolar
Python kurulum ekrani (Add to PATH isaretli)
REPL ekran goruntusu
Python kullanim alanlari infografik
  Analoji ve Benzetmeler
  1. Python = Ingilizce: en yaygin ortak dil
  2. Kurulum = Alet cantasi hazirlama: once aletler lazim
  3. REPL = Hesap makinesi: aninda sonuc
  4. PATH = Adres defteri: bilgisayar Python i nerede bulacagini bilir
  Öğrenci Soru-Cevap
Python neden yapay zekada populer? - Kolay sozdizimi, zengin kutuphane ekosistemi (NumPy, TensorFlow, PyTorch).
PATH ne ise yarar? - Python un komut satirindan her yerden calistirilabilmesini saglar.
REPL ne demek? - Read-Eval-Print Loop: kod yazin, calissin, sonuc gorsuun.
________________________________________________________________________________
	  E4  |  DERİNLEŞTİRME (ELABORATE)  —  Transfer & Pekiştirme



  Süre: 10 dakika
  Uygulama Etkinliği: "Python Temel Komut Pratiigi"
Türü: Bireysel Uygulama
Amacı: Python REPL de temel komutlari calistirmak.
  Yönerge Adımları
  1. REPL de aritmetik islemler yapin (toplama, cikarma, carpma, bolme).
  2. Degisken tanimlama ve yazdirma (x = 5, print(x)).
  3. String (metin) islemleri yapin.
  4. type() fonksiyonu ile veri tiplerini kontrol edin.
  5. Basit bir input/output programi yazin.
Beklenen Ürün: Python Temel Komut Defteri
  Transfer Soruları
  1. Baska hangi programlama dilleri yapay zekada kullanilir?
  2. Python un dezavantajlari nelerdir?
  3. Jupyter Notebook nedir?
İlişkili Disiplinler: Bilgisayar Bilimi, Matematik, Yazilim Muhendisligi
  Gerçek Yaşam Problemi
	Python kuruldu ama komut satirinda 'python' yazinca hata aliyor. Neden?

Cozum: PATH ayari yapilmamis. Cozum: 1) Python i kaldir ve tekrar kur (Add to PATH isaretli). 2) Veya elle PATH e Python dizinini ekle.



Yaratıcı Görev: Python in 5 farkli kullanim alanini arastirin ve poster hazirlaayin.
________________________________________________________________________________
	  E5  |  DEĞERLENDİRME (EVALUATE)  —  Öğrenmeyi Ölçme



  Süre: 8 dakika
  Öz Değerlendirme Kontrol Listesi
  ☐  Python 3 u basariyla kurabiliyorum.
  ☐  REPL de temel komutlari calistirabiliyorum.
  ☐  PATH kavramini anliyorum.
  ☐  print() ve degisken kullanabiiliyorum.
  ☐  Python surumunu kontrol edebiliyorum.
  Öz Değerlendirme Soruları
  1. Python kurulumumu basariyla tamamladim mi?
  2. REPL de rahatca komut yazabiliyor muyum?
  3. PATH sorununu cozebilir miyim?
  Biçimlendirici Değerlendirme (Kısa Quiz)
	No
	Soru
	Cevap

	1
	Python kimin tarafindan gelistirildi?
	Guido van Rossum

	2
	Python surumunu nasil kontrol edersiniz?
	python --version

	3
	REPL ne demektir?
	Read-Eval-Print Loop

	4
	pip ne ise yarar?
	Python paket yoneticisi

	5
	PATH neden onemli?
	Python un her yerden calistirilabilmesi icin



  Tartışma Soruları
Açık Uçlu:
  1. Python neden bu kadar populer?
  2. Python in gelecegi nasil olacak?
  3. Yapay zeka icin baska diller kullanilabilir mi?
Eleştirel Düşünme:
  1. Python her sey icin en iyi dil midir?
  2. Kolay olmasi Python i daha mi az guclu kilar?
  3. Python ogrenmeek yapay zeka ogrenmek mi demektir?
________________________________________________________________________________


	  UYGULAMALAR  |  Hands-On Uygulama Etkinlikleri



  Adım Adım Uygulama: "Python 3 Kurulum Uygulamasi"
Hedef: Python 3 u kurmak ve temel komutlari calistirmak.
	Adım
	İşlem
	Beklenen Sonuç

	1. Indirme
	python.org dan Python 3 indirin
	Dosya indirme

	2. Kurulum
	Kurulum sihirbazini calistirin (PATH isaretli)
	Yazilim kurulumu

	3. Dogrulama
	python --version ile kontrol edin
	Kurulum testi

	4. REPL
	Python REPL de komut yazin
	Interaktif kullanim

	5. print
	print('Merhaba YZ!') calistirin
	Ilk program



Tamamlanma Kriteri: Python 3 kurulu, PATH ayarli ve REPL calisiyor.
________________________________________________________________________________
  Canlı Demo: "Canli Python Kurulumu"
Eğitmenin Gösterdiği: Python kurulumunu adim adim gosterir.
Öğrencinin Tekrarladığı: Kendi bilgisayarina Python kurar.
Dikkat Noktaları: Add to PATH secenegini MUTLAKA isaretle!
________________________________________________________________________________
  Pratik Alıştırmalar
	No
	Zorluk
	Görev

	1
	Baslangic
	Python kurun ve surumu kontrol edin

	2
	Orta
	REPL de 10 farkli aritmetik islem yapin

	3
	Ileri
	input() ile kullanicidan isim alip selam veren program yazin



________________________________________________________________________________
  Vaka Çalışması: "PATH Sorunu"
	Ogrenci Python u kurdu ama komut satirinda 'python' yazinca 'command not found' hatasi aliyor. Kurulum sirasinda Add to PATH secenegini isaretlememis. Ne yapmali?



Beklenen Çıktı: PATH cozumu: Python i kaldir ve tekrar kur (Add to PATH isaretli) veya sistem ortam degiskenlerine elle Python dizinini ekle.
________________________________________________________________________________


	  DERS SONU  |  Özet, Kapanış ve Köprü



  Özet
Python 3 u basariyla kurduk, PATH ayarini yaptik ve REPL de ilk komutlarimizi calistirdik.
  Anahtar Kavramlar
	  Python
	  Python 3

	  REPL
	  PATH

	  pip
	  print()

	  Degisken
	  Veri Tipi



  Bir Sonraki Dersle Köprü
Python kurulumunu tamamladik; bir sonraki derste PyCharm IDE kurulumunu yapacagiz.
  Ev Ödevi / Hazırlık
	Gorev: Python REPL de 20 farkli komut calistirin ve sonuclari not edin.
Teslim: Sonraki ders.
Kriter: En az 5 farkli veri tipi (int, float, str, bool, list) kullanilmis olmali.



________________________________________________________________________________
	  NOTLAR  |  Öğretmen Notları



  Dersten Önce Yapılacaklar
Python 3 kurulum dosyalarini onceden indirin (internet yavas olabilir).
Her bilgisayarin isletim sistemini kontrol edin.
Yedek USB bellekte kurulum dosyasi bulundurun.
  Olası Zorluklar ve Çözümler
	Zorluk
	Çözüm

	Internet yavas
	Onceden indirip USB ile dagitin

	PATH hatasi
	Adim adim rehber ile elle PATH ayari yapin

	Eski isletim sistemi
	Uyumlu Python surumunu indirin



Zaman Yönetimi: Teori %30, Uygulama %70.
  Alternatif Plan (B Planı)
	Internet yoksa onceden indirmis kurulum dosyalarindan offline kurulum yapin.





━━━  2. SAAT  ━━━
PyCharm IDE Kurulumu ve Yapilandirmasi

	  KAZANIMLAR  |  Öğrenme Kazanımları



Genel Kazanım: PyCharm IDE yi kurar ve Python gelistirme ortamini yapilandirir.

	Kod
	Kazanım
	Bilişsel Düzey

	2.1.4
	PyCharm IDE kurulum asamalarini bilir.
	Bilgi

	2.1.5
	PyCharm kurulumunu gerceklestirir.
	Uygulama

	2.1.6
	PyCharm da ilk Python projesini olusturur.
	Uygulama



	  ÖN BİLGİ  |  Ön Bilgi ve Hazırlık



Ön Koşul Bilgiler: Python 3 kurulumunu tamamlamis olmak.
  Öğrencinin Bilmesi Gerekenler
Python in komut satirindan calistigiini.
IDE nin ne oldugunu (Entegre Gelistirme Ortami).
Proje kavraminii.
  Olası Kavram Yanılgıları
IDE olmadan Python yaziilamadiigi sanilmasi.
PyCharm in Python in bir parcasi oldugu dusuncesi.
Community Edition in yetersiz oldugu yanilgisi.
  Hazırlık Materyalleri
Bilgisayar (Python 3 kurulu)
Internet baglantisi
PyCharm Community Edition kurulum dosyasi
Projeksiyon
________________________________________________________________________________
	  E1  |  GİRME (ENGAGE)  —  Dikkat Çekme & Merak Uyandırma



  Süre: 5 dakika
Dikkat Çekici Soru: "Python i komut satirinda yazdik ama buyuk projeler icin daha guclu bir araca ihtiyacimiz var: PyCharm! Kod yazmayi kolaylastiran bir atolye gibi."
Günlük Hayat Bağlantısı: Marangozun atolyesi gibi: tezgah, aletler, malzeme hepsi bir arada. PyCharm da programci icin ayni isi yapar.
  Ön Bilgi Yoklama Soruları
  1. IDE ne demektir?
  2. PyCharm in avantajlari nelerdir?
  3. Community ve Professional Edition farki nedir?
  Motivasyon Etkinliği: "IDE Arastirmasi"
Açıklama: Farkli Python IDE lerini karsilastirma.
Yönerge: Egitmen PyCharm, VS Code ve Jupyter Notebook u gosterir. Ogrenciler avantaj ve dezavantajlarini tartisir.
  Senaryo / Problem Durumu
	Bir gelistirici sadece Notepad ile Python kodu yaziyor. Neden IDE kullanmasi daha verimli olur?



________________________________________________________________________________
	  E2  |  KEŞİF (EXPLORE)  —  Aktif Keşif & Deneyimleme



  Süre: 10 dakika
  Keşif Etkinliği: "PyCharm Kurulum ve Ilk Proje"
Türü: Bireysel Uygulamali Calisma
Amacı: PyCharm i kurmak ve ilk projeyi olusturmak.
Malzemeler: Bilgisayar, internet, PyCharm Community Edition
  Yönerge Adımları
  1. jetbrains.com dan PyCharm Community Edition indirin.
  2. Kurulum sihirbazini calistirin ve varsayilan ayarlarla kurun.
  3. PyCharm i baslatin ve 'New Project' secin.
  4. Interpreter olarak kurulu Python 3 u secin.
  5. main.py dosyasina print('Merhaba PyCharm!') yazin ve calistirin (Shift+F10).
Öğrenci Rolü: Gelistirici: IDE ortamini hazirlayan
Öğretmen Rolü: Kurulum ve proje yapilandirmasini kontrol eder
Beklenen Ürün: PyCharm ile Calisan Ilk Proje
  Araştırma Soruları
  1. JetBrains hangi diger IDE leri uretir?
  2. VS Code ile PyCharm farki nedir?
  3. PyCharm kisa yollari (shortcuts) nelerdir?
Grupla Çalışma Kuralları: Community Edition ucretsiz ve yeterli! Professional Edition gereksiz.
________________________________________________________________________________


	  E3  |  AÇIKLAMA (EXPLAIN)  —  Kavramları Yapılandırma



  Süre: 12 dakika
  Temel Kavramlar
	Kavram
	Tanım
	Örnek
	Görsel Açıklama

	IDE
	Integrated Development Environment: Entegre Gelistirme Ortami
	Kod editoru + derleyici + hata ayiklayici bir arada
	IDE ekran goruntusu

	PyCharm
	JetBrains tarafindan gelistirilen Python IDE si
	Kod tamamlama, hata ayiklama, proje yonetimi
	PyCharm arayuzu

	Proje
	Ilgili dosya ve klasorlerin organize edildigi yapi
	Her uygulama bir proje olarak olusturulur
	Proje yapisi gorseli

	Interpreter
	Python kodunu calistiran yorumlayici
	PyCharm proje ayarlarinda secilir
	Interpreter ayari

	Run
	Kodu calistirma islemi
	Shift+F10 veya yesil ucgen butonu
	Run butonu gorseli



  Konu Anlatımı
IDE (Entegre Gelistirme Ortami), kod yazma, calistirma, hata ayiklama ve proje yonetimini tek bir arayuzde birlestiren yazilimdir. Not defteri ile kod yazmak mumkun ama IDE ile cok daha verimlidir.
PyCharm, JetBrains sirketinin Python icin ozel olarak gelistirdigi profesyonel bir IDE dir. Community Edition ucretsizdir ve yapay zeka gelistirme icin yeterlidir. Kod tamamlama, syntax vurgulama ve hata ayiklama gibi ozellikler uretkenliigi arttirir.
Her PyCharm projesi bir Python interpreter a baglanir. Bu interpreter, kodun hangi Python surumu ile calisacagini belirler. Proje olusturururken dogru interpreter secimi kritiktir.
  Somut Örnekler
	Örnek
	Açıklama
	Günlük Hayat Bağlantısı

	Yeni Proje
	File > New Project > Pure Python
	Proje olusturma

	Interpreter
	Python 3.11 secimi
	Dogru surum eslesmesi

	Run
	Shift+F10 ile calistirma
	Hizli calistirma

	Hata
	Syntax hatasi kirmizi altcizgi
	Aninda hata tespiti



  Görseller ve Tablolar
PyCharm arayuzu tanitimi
Proje olusturma ekrani
Interpreter ayar ekrani
  Analoji ve Benzetmeler
  1. IDE = Atolye: tum aletler bir arada
  2. PyCharm = Profesyonel tezgah: issi kolaylastirir
  3. Interpreter = Motor: kodu calistiran guc
  4. Run = Dugme: motoru calistir
  Öğrenci Soru-Cevap
IDE neden gerekli? - Kod tamamlama, hata ayiklama ve proje yonetimi ile verimliligi arttirir.
Community vs Professional? - Community ucretsiz ve yapay zeka gelistirme icin yeterli.
Interpreter ne ise yarar? - Kodun hangi Python surumu ile calisacagini belirler.
________________________________________________________________________________
	  E4  |  DERİNLEŞTİRME (ELABORATE)  —  Transfer & Pekiştirme



  Süre: 10 dakika
  Uygulama Etkinliği: "PyCharm ile Kod Yazma Pratiigi"
Türü: Bireysel Uygulama
Amacı: PyCharm in temel ozelliklerini kullanarak kod yazmak.
  Yönerge Adımları
  1. Yeni bir Python dosyasi olusturun (File > New > Python File).
  2. Degiskenler tanimlayin ve print ile yazdirin.
  3. Kod tamamlama ozelligini deneyin (Ctrl+Space).
  4. Bilerek bir hata yapin ve PyCharm in uyarisini gorun.
  5. Hata ayiklayiciyi (debugger) baslatmayi deneyin.
Beklenen Ürün: PyCharm Ozellik Kesfii Raporu
  Transfer Soruları
  1. Baska IDE ler (VS Code, Jupyter) nasil calisir?
  2. Versiyon kontrol (Git) nedir?
  3. Sanal ortam (virtual environment) nedir?
İlişkili Disiplinler: Yazilim Muhendisligi, Bilgisayar Bilimi
  Gerçek Yaşam Problemi
	PyCharm proje olustururken 'No Python interpreter configured' hatasi aliyor. Ne yapmali?

Cozum: Settings > Project > Python Interpreter yoluna gidin ve kurulu Python 3 u secin. Otomatik algilanmadiysa 'Add Interpreter' ile elle yolu gosterin.



Yaratıcı Görev: PyCharm kisa yollari (shortcuts) posteri hazirlaayin: en cok kullanilan 10 kisa yol.
________________________________________________________________________________
	  E5  |  DEĞERLENDİRME (EVALUATE)  —  Öğrenmeyi Ölçme



  Süre: 8 dakika
  Öz Değerlendirme Kontrol Listesi
  ☐  PyCharm i basariyla kurabiiliyorum.
  ☐  Yeni proje olusturabiliyorum.
  ☐  Interpreter ayarini yapabiliyorum.
  ☐  Kod yazip calistirabiliyorum (Shift+F10).
  ☐  Kod tamamlama ozelligini kullanabiliyorum.
  Öz Değerlendirme Soruları
  1. PyCharm arayuzune alistiim mi?
  2. Proje olusturma ve calistirmayi biliiyor muyum?
  3. Interpreter ayarini yapabilir miyim?
  Biçimlendirici Değerlendirme (Kısa Quiz)
	No
	Soru
	Cevap

	1
	IDE ne demektir?
	Integrated Development Environment

	2
	PyCharm i kim gelistirdi?
	JetBrains

	3
	Kodu calistirma kisa yolu?
	Shift+F10

	4
	Interpreter ne yapar?
	Python kodunu calistirir

	5
	Community Edition ucretli mi?
	Hayir, ucretsiz



  Tartışma Soruları
Açık Uçlu:
  1. En iyi Python IDE hangisi?
  2. IDE mi metin editoru mu tercih edersiniz?
  3. PyCharm in en begendiginiz ozelligi?
Eleştirel Düşünme:
  1. IDE olmadan buyuk proje gelistirilebilir mi?
  2. PyCharm cok mu agir bir IDE?
  3. Bulut tabanli IDE ler gelecekte masaustu IDE lerin yerini alir mi?
________________________________________________________________________________


	  UYGULAMALAR  |  Hands-On Uygulama Etkinlikleri



  Adım Adım Uygulama: "PyCharm Kurulum ve Kullanim Uygulamasi"
Hedef: PyCharm i kurmak, proje olusturmak ve kod yazmak.
	Adım
	İşlem
	Beklenen Sonuç

	1. Indirme
	PyCharm Community Edition indirin
	Dosya indirme

	2. Kurulum
	Kurulum sihirbazini calistirin
	Yazilim kurulumu

	3. Proje
	New Project ile ilk projeyi olusturun
	Proje yapilandirma

	4. Interpreter
	Python 3 interpreter secin
	Ortam ayari

	5. Calistirma
	print komutu yazin ve Shift+F10
	Ilk calistirma



Tamamlanma Kriteri: PyCharm kurulu, proje olusturulmus ve kod calisiyor.
________________________________________________________________________________
  Canlı Demo: "Canli PyCharm Kurulumu"
Eğitmenin Gösterdiği: PyCharm kurulum ve proje olusturma adimlarini gosterir.
Öğrencinin Tekrarladığı: Kendi bilgisayarina PyCharm kurar ve proje olusturur.
Dikkat Noktaları: Interpreter ayarini kontrol edin!
________________________________________________________________________________
  Pratik Alıştırmalar
	No
	Zorluk
	Görev

	1
	Baslangic
	PyCharm i kurun ve ilk projeyi olusturun

	2
	Orta
	5 farkli Python dosyasi olusturup calistirin

	3
	Ileri
	Debugger ile adim adim kod takibi yapin



________________________________________________________________________________
  Vaka Çalışması: "Interpreter Hatasi"
	Ogrenci PyCharm da proje olusturdu ama 'Run' basinca hic bir sey olmuyor. Console da 'No Python interpreter' yaziyor. Ne yapmali?



Beklenen Çıktı: Interpreter cozumu: Settings > Project > Python Interpreter > Add Interpreter ile Python 3 yolunu gosterin.
________________________________________________________________________________


	  DERS SONU  |  Özet, Kapanış ve Köprü



  Özet
PyCharm Community Edition i kurduk, ilk projemizi olusturduk ve Python kodunu IDE icinde calistirdik.
  Anahtar Kavramlar
	  IDE
	  PyCharm

	  Community Edition
	  Proje

	  Interpreter
	  Run

	  Shift+F10
	  Kod Tamamlama

	  Debugger
	



  Bir Sonraki Dersle Köprü
Gelistirme ortamimiz hazir; bir sonraki derste Python kutuphanelerini kuracagiz.
  Ev Ödevi / Hazırlık
	Gorev: PyCharm da 3 farkli Python programi yazin (hesap makinesi, selam, liste islemleri).
Teslim: Sonraki ders.
Kriter: Her programin hatasiz calismasi.



________________________________________________________________________________
	  NOTLAR  |  Öğretmen Notları



  Dersten Önce Yapılacaklar
PyCharm kurulum dosyalarini onceden indirin.
Bilgisayarlarda yeterli disk alani oldugunu kontrol edin (en az 1 GB).
Ornek proje dosyasi hazirlaayin.
  Olası Zorluklar ve Çözümler
	Zorluk
	Çözüm

	Yavas bilgisayar
	PyCharm yerine hafif alternatif (VS Code) onerin

	Interpreter bulunamiyor
	Python kurulum dizinini elle gosterin

	Ekran cozunurlugu dusuk
	PyCharm font boyutunu artirin



Zaman Yönetimi: Teori %25, Uygulama %75.
  Alternatif Plan (B Planı)
	PyCharm kurulamiiyorsa VS Code veya IDLE ile devam edilebilir.





━━━  3. SAAT  ━━━
Python Kutuphanelerinin Kurulumu (pip)

	  KAZANIMLAR  |  Öğrenme Kazanımları



Genel Kazanım: pip ile yapay zeka icin gerekli Python kutuphanelerini kurar ve yonetir.

	Kod
	Kazanım
	Bilişsel Düzey

	2.1.7
	Python kutuphanelerini secer ve onemini aciklar.
	Bilgi

	2.1.8
	pip ile kutuphane kurulumunu gerceklestirir.
	Uygulama

	2.1.9
	Kurulu kutuphaneleri import ederek test eder.
	Uygulama



	  ÖN BİLGİ  |  Ön Bilgi ve Hazırlık



Ön Koşul Bilgiler: Python 3 ve PyCharm kurulumunu tamamlamis olmak.
  Öğrencinin Bilmesi Gerekenler
pip in Python paket yoneticisi oldugunu.
Kutuphanenin hazir kod koleksiyonu oldugunu.
Komut satirini kullanmayi.
  Olası Kavram Yanılgıları
Tum kutuphanelerin Python ile birlikte geldigii sanilmasi.
pip install komutunun tehlikeli oldugu dusuncesi.
Her kutuphanenin her Python surumu ile uyumlu oldugu yanilgisi.
  Hazırlık Materyalleri
Bilgisayar (Python 3 + PyCharm kurulu)
Internet baglantisi
Kutuphane listesi
Terminal/Komut Satiri
________________________________________________________________________________
	  E1  |  GİRME (ENGAGE)  —  Dikkat Çekme & Merak Uyandırma



  Süre: 5 dakika
Dikkat Çekici Soru: "Python tek basina guclu ama kutuphanelerle cok daha guclu! NumPy, Matplotlib, Scikit-learn... Bunlar yapay zekanin yapi taslariidir."
Günlük Hayat Bağlantısı: Mutfak gibi dusunun: Python ocak, kutuphaneler ise baharatlar ve malzemeler. Malzemesiz yemek yapilmaz!
  Ön Bilgi Yoklama Soruları
  1. pip ne ise yarar?
  2. NumPy nedir?
  3. Kutuphane nasil kurulur?
  Motivasyon Etkinliği: "Kutuphane Kesfi"
Açıklama: Yapay zeka icin gerekli kutuphaneleri arastirma.
Yönerge: Egitmen NumPy, Matplotlib, Scikit-learn, Pandas kutuphanelerini tanitir. Ogrenciler her birinin ne ise yaradigiini arastirir.
  Senaryo / Problem Durumu
	Bir veri bilimci yeni bir proje baslatiyor. Hangi kutuphaneleri kurmali?



________________________________________________________________________________
	  E2  |  KEŞİF (EXPLORE)  —  Aktif Keşif & Deneyimleme



  Süre: 10 dakika
  Keşif Etkinliği: "pip ile Kutuphane Kurulumu"
Türü: Bireysel Uygulamali Calisma
Amacı: Yapay zeka icin gerekli kutuphaneleri pip ile kurmak.
Malzemeler: Bilgisayar, terminal, internet baglantisi
  Yönerge Adımları
  1. Terminal/CMD acin.
  2. pip install numpy komutu ile NumPy kurun.
  3. pip install matplotlib ile Matplotlib kurun.
  4. pip install scikit-learn ile Scikit-learn kurun.
  5. pip list ile kurulu kutuphaneleri listeleyin.
Öğrenci Rolü: Sistem yoneticisi: gelistirme ortamini hazirlayan
Öğretmen Rolü: Kurulum surecini izler ve hatalari giderir
Beklenen Ürün: Kutuphaneleri Kurulmus Gelistirme Ortami
  Araştırma Soruları
  1. requirements.txt dosyasi nedir?
  2. Sanal ortam (venv) neden kullanilir?
  3. conda ile pip farki nedir?
Grupla Çalışma Kuralları: Internet baglantisi kesilirse kurulum basarisiz olur! Onceden indirmis paketler yedek olarak bulundurulmali.
________________________________________________________________________________


	  E3  |  AÇIKLAMA (EXPLAIN)  —  Kavramları Yapılandırma



  Süre: 12 dakika
  Temel Kavramlar
	Kavram
	Tanım
	Örnek
	Görsel Açıklama

	pip
	Python Package Installer: paket yoneticisi
	pip install paket_adi ile kutuphane kurar
	pip install ornegi

	NumPy
	Numerical Python: sayisal hesaplama kutuphanesi
	Dizi, matris islemleri ve matematiksel fonksiyonlar
	NumPy dizi ornegi

	Matplotlib
	Veri gorsellesstirme kutuphanesi
	Grafik, tablo ve diyagram olusturma
	Matplotlib grafik ornegi

	Scikit-learn
	Makine ogrenmesi kutuphanesi
	Siniflandirma, regresyon, kumeleme algoritmalari
	Scikit-learn logosu

	import
	Kutuphanenin Python koduna dahil edilmesi
	import numpy as np seklinde kullanilir
	import ornegi



  Konu Anlatımı
pip (Python Package Installer), Python in resmi paket yoneticisidir. PyPI (Python Package Index) deposundan binlerce kutuphaneeyi indirip kurmanizi saglar. pip install, pip uninstall, pip list temel komutlaridir.
Yapay zeka gelistirme icin temel kutuphaneler: NumPy (sayisal hesaplama), Matplotlib (gorsellesstirme), Scikit-learn (makine ogrenmesi), Pandas (veri analizi). Bu kutuphaneler birlikte calisiir ve birbirini tamamlar.
import komutu, kurulu bir kutuphanenin Python kodunuza dahil edilmesini saglar. import numpy as np yazdiginizda NumPy kutuphanesini 'np' kisaltmasiyla kullanabilirsiniz. Bu kisaltmalar topluluk standartlaridir.
  Somut Örnekler
	Örnek
	Açıklama
	Günlük Hayat Bağlantısı

	NumPy Kurulum
	pip install numpy
	Terminal komutu

	Import
	import numpy as np
	Kod icinde kullanim

	Test
	np.array([1,2,3])
	NumPy dizisi olusturma

	Liste
	pip list
	Kurulu paketleri gorme



  Görseller ve Tablolar
pip install ekran goruntusu
Kutuphane ekosistemi haritasi
import akis semasi
  Analoji ve Benzetmeler
  1. pip = App Store: ihtiyaciniz olan araci indirin
  2. Kutuphane = Lego parcasi: birlestirerek buyuk seyler yapin
  3. import = Alet cantasindan aleti cikarma
  4. NumPy = Hesap makinesi: matematiksel islemlerin temeli
  Öğrenci Soru-Cevap
pip install basarisiz olursa? - Internet baglantisini kontrol edin veya --user parametresi ekleyin.
import hatasi aliirsam? - Kutuphane kurulu olmayabilir, pip install ile kurun.
Hangi kutuphaneler sart? - YZ icin minimum: NumPy, Matplotlib, Scikit-learn.
________________________________________________________________________________
	  E4  |  DERİNLEŞTİRME (ELABORATE)  —  Transfer & Pekiştirme



  Süre: 10 dakika
  Uygulama Etkinliği: "Kutuphane Test ve Dogrulama"
Türü: Bireysel Uygulama
Amacı: Kurulu kutuphaneleri import edip test etmek.
  Yönerge Adımları
  1. PyCharm da yeni dosya olusturun.
  2. import numpy as np yazin ve np.__version__ yazdirin.
  3. import matplotlib.pyplot as plt yazin.
  4. import sklearn yazin ve sklearn.__version__ yazdirin.
  5. Basit bir NumPy dizisi olusturun ve yazdirin.
Beklenen Ürün: Kutuphane Test Raporu
  Transfer Soruları
  1. Paket yonetimi baska dillerde nasil yapilir (npm, pip, cargo)?
  2. Kutuphane versiyonlama neden onemli?
  3. Dependency conflict (bagiimlilik catismasi) nedir?
İlişkili Disiplinler: Yazilim Muhendisligi, Sistem Yonetimi
  Gerçek Yaşam Problemi
	pip install numpy yazinca 'Permission denied' hatasi aliyor. Cozum?

Cozum: 1) pip install --user numpy ile kullanici dizinine kurun. 2) Veya terminal i yonetici olarak calistirin. 3) Sanal ortam (venv) kullanin.



Yaratıcı Görev: Yapay zeka kutuphaneleri infografigi hazirlaayin: kutuphane adi, ne ise yarar, ornek kullanim.
________________________________________________________________________________
	  E5  |  DEĞERLENDİRME (EVALUATE)  —  Öğrenmeyi Ölçme



  Süre: 8 dakika
  Öz Değerlendirme Kontrol Listesi
  ☐  pip ile kutuphane kurabiliiyorum.
  ☐  import ile kutuphaneeyi koda dahil edebiliyorum.
  ☐  pip list ile kurulu paketleri gorebiliyorum.
  ☐  NumPy, Matplotlib, Scikit-learn kurulu.
  ☐  Import hatasini cozebiliyorum.
  Öz Değerlendirme Soruları
  1. Gerekli tum kutuphaneler kurulu mu?
  2. import komutunu dogru kullanabiliyor muyum?
  3. pip komutlarini biliiyor muyum?
  Biçimlendirici Değerlendirme (Kısa Quiz)
	No
	Soru
	Cevap

	1
	pip ne ise yarar?
	Python paket yoneticisi

	2
	NumPy ne icin kullanilir?
	Sayisal hesaplama

	3
	import numpy as np ne yapar?
	NumPy yi np kisaltmasiyla dahil eder

	4
	pip list ne gosterir?
	Kurulu paketleri

	5
	Matplotlib ne icin?
	Veri gorsellesstirme



  Tartışma Soruları
Açık Uçlu:
  1. En onemli yapay zeka kutuphanesi hangisi?
  2. pip mi conda mi?
  3. Kutuphane guncellemeleri neden onemli?
Eleştirel Düşünme:
  1. Cok fazla kutuphane kullanmak sorun yaratir mi?
  2. Her kutuphane guvenilir mi?
  3. Kutuphanesiz yapay zeka gelistirilebilir mi?
________________________________________________________________________________


	  UYGULAMALAR  |  Hands-On Uygulama Etkinlikleri



  Adım Adım Uygulama: "Kutuphane Kurulum Uygulamasi"
Hedef: Yapay zeka kutuphanelerini kurmak ve test etmek.
	Adım
	İşlem
	Beklenen Sonuç

	1. NumPy
	pip install numpy
	Sayisal hesaplama

	2. Matplotlib
	pip install matplotlib
	Gorsellesstirme

	3. Scikit-learn
	pip install scikit-learn
	Makine ogrenmesi

	4. Test
	import ve version kontrolu
	Dogrulama

	5. Ornek
	np.array([1,2,3]) olusturun
	Ilk kullanim



Tamamlanma Kriteri: 3 temel kutuphane kurulu ve import calisiyor.
________________________________________________________________________________
  Canlı Demo: "Canli pip Kurulumu"
Eğitmenin Gösterdiği: Terminal de pip komutlarini canli gosterir.
Öğrencinin Tekrarladığı: Kendi bilgisayarinda kutuphaneleri kurar.
Dikkat Noktaları: Internet baglantisi gerekli! Hata aliirsaniz --user parametresi ekleyin.
________________________________________________________________________________
  Pratik Alıştırmalar
	No
	Zorluk
	Görev

	1
	Baslangic
	3 kutuphaneeyi kurun ve pip list ile dogrulayin

	2
	Orta
	Her kutuphaneeyi import edip version bilgisini yazdirin

	3
	Ileri
	requirements.txt dosyasi olusturun ve pip install -r ile toplu kurulum yapin



________________________________________________________________________________
  Vaka Çalışması: "Bagiimlilik Hatasi"
	Ogrenci scikit-learn kurarken hata aliyor: NumPy versiyonu uyumsuz. Ne yapmali?



Beklenen Çıktı: Versiyon uyumu: pip install --upgrade numpy ile NumPy guncelle, sonra scikit-learn tekrar kur.
________________________________________________________________________________


	  DERS SONU  |  Özet, Kapanış ve Köprü



  Özet
pip ile NumPy, Matplotlib ve Scikit-learn kutuphanelerini kurduk, import ile dahil ettik ve calistigini dogruladik.
  Anahtar Kavramlar
	  pip
	  pip install

	  pip list
	  NumPy

	  Matplotlib
	  Scikit-learn

	  import
	  as (kisaltma)

	  PyPI
	  requirements.txt



  Bir Sonraki Dersle Köprü
Gelistirme ortami ve kutuphaneler hazir; bir sonraki derste NumPy ile dizi ve matris islemlerine basliyoruz!
  Ev Ödevi / Hazırlık
	Gorev: 5 farkli Python kutuphanesini arastirin (Pandas, TensorFlow, Keras, OpenCV, NLTK) ve ne ise yaradiklarini yazin.
Teslim: Sonraki ders.
Kriter: Her kutuphane icin en az 3 satirlik aciklama.



________________________________________________________________________________
	  NOTLAR  |  Öğretmen Notları



  Dersten Önce Yapılacaklar
Internet baglantisini test edin.
pip --version ile pip in calistiginii dogrulayin.
Yedek olarak kutuphanelerin .whl dosyalarini indirin.
  Olası Zorluklar ve Çözümler
	Zorluk
	Çözüm

	Internet yok
	Onceden indirmis .whl dosyalari ile offline kurulum

	Permission hatasi
	--user parametresi veya venv kullanin

	Versiyon uyumsuzlugu
	pip install --upgrade ile guncelleyin



Zaman Yönetimi: Teori %20, Uygulama %80.
  Alternatif Plan (B Planı)
	Internet yoksa onceden hazirlanmis sanal ortam (venv) klasorunu kopyalaayin.





━━━  4. SAAT  ━━━
NumPy ile Dizi ve Matris Olusturma

	  KAZANIMLAR  |  Öğrenme Kazanımları



Genel Kazanım: NumPy kutuphanesi ile dizi (array) ve matris (matrix) olusturur ve temel islemleri yapar.

	Kod
	Kazanım
	Bilişsel Düzey

	2.2.1
	NumPy ile dizi olusturmayi aciklar ve uygular.
	Uygulama

	2.2.2
	NumPy ile matris olusturur.
	Uygulama

	2.2.3
	Dizi ve matris uzerinde temel islemleri gerceklestirir.
	Uygulama



	  ÖN BİLGİ  |  Ön Bilgi ve Hazırlık



Ön Koşul Bilgiler: Python 3, PyCharm ve NumPy kutuphanesinin kurulu olmasi.
  Öğrencinin Bilmesi Gerekenler
Python da liste (list) kavramini.
Temel matematik islemlerini (toplama, carpma, matris).
import numpy as np kullanimi.
  Olası Kavram Yanılgıları
Python listesi ile NumPy dizisinin ayni oldugu sanilmasi.
Matrisin sadece matematikciiler icin oldugu dusuncesi.
NumPy nin yavas oldugu yanilgisi (aslinda C ile yazilmis, cok hizli).
  Hazırlık Materyalleri
Bilgisayar (Python + PyCharm + NumPy kurulu)
PyCharm projesi
NumPy dokumantasyonu
________________________________________________________________________________
	  E1  |  GİRME (ENGAGE)  —  Dikkat Çekme & Merak Uyandırma



  Süre: 5 dakika
Dikkat Çekici Soru: "Yapay zeka verilerle calisir. Verileri organize etmenin en iyi yolu: diziler ve matrisler! NumPy bunlari hizli ve verimli yapar."
Günlük Hayat Bağlantısı: Excel tablosu gibi dusunun: satirlar ve sutunlar. NumPy dizisi = tek satir, NumPy matrisi = tam tablo. Yapay zeka bu tablolari isler.
  Ön Bilgi Yoklama Soruları
  1. Dizi (array) nedir?
  2. Matris nedir?
  3. NumPy neden Python listesinden hizli?
  Motivasyon Etkinliği: "Veri Yapilari Karsilastirmasi"
Açıklama: Python listesi ile NumPy dizisini karsilastirma.
Yönerge: Egitmen ayni islemi Python listesi ve NumPy dizisi ile yapar, hiz farkini gosterir. Ogrenciler farki gozlemler.
  Senaryo / Problem Durumu
	1 milyon sayiyi toplamak istiyorsunuz. Python listesi mi NumPy dizisi mi kullanirsiniz? Neden?



________________________________________________________________________________
	  E2  |  KEŞİF (EXPLORE)  —  Aktif Keşif & Deneyimleme



  Süre: 10 dakika
  Keşif Etkinliği: "NumPy Dizi ve Matris Calismasi"
Türü: Bireysel Uygulamali Calisma
Amacı: NumPy ile cesitli dizi ve matris olusturmak.
Malzemeler: Bilgisayar, PyCharm, NumPy kutuphanesi
  Yönerge Adımları
  1. np.array([1,2,3,4,5]) ile 1 boyutlu dizi olusturun.
  2. np.array([[1,2],[3,4]]) ile 2 boyutlu matris olusturun.
  3. np.zeros((3,3)) ile sifir matrisi olusturun.
  4. np.ones((2,4)) ile bir matrisi olusturun.
  5. np.arange(0,10,2) ile aralikli dizi olusturun.
Öğrenci Rolü: Veri bilimci: verileri duzenleeyen
Öğretmen Rolü: Dizi ve matris olusturma islemlerini kontrol eder
Beklenen Ürün: NumPy Dizi/Matris Ornekleri
  Araştırma Soruları
  1. NumPy broadcasting nedir?
  2. Dizi dilimleme (slicing) nasil yapilir?
  3. NumPy ve MATLAB farki nedir?
Grupla Çalışma Kuralları: Matris boyutlari uyumlu olmali! Uyumsuz boyutlarda islem hatasi alinir.
________________________________________________________________________________


	  E3  |  AÇIKLAMA (EXPLAIN)  —  Kavramları Yapılandırma



  Süre: 12 dakika
  Temel Kavramlar
	Kavram
	Tanım
	Örnek
	Görsel Açıklama

	ndarray
	NumPy nin temel veri yapisi: n-boyutlu dizi
	np.array() ile olusturulur
	ndarray gorseli

	1D Array
	Tek boyutlu dizi (vektor)
	np.array([1,2,3])
	1D dizi gorseli

	2D Array
	Iki boyutlu dizi (matris)
	np.array([[1,2],[3,4]])
	2D matris gorseli

	shape
	Dizinin boyut bilgisi
	arr.shape -> (3,) veya (2,2)
	shape ornegi

	dtype
	Dizinin veri tipi
	int32, float64 vb.
	dtype ornegi



  Konu Anlatımı
NumPy dizisi (ndarray), Python listesinden farkli olarak homojen (ayni tipte) verileri saklar ve vektorize islemler sayesinde cok hizlidir. 1 milyon elemanli bir diziyi toplamak NumPy ile Python listesinden 50-100 kat daha hizli olabilir.
Dizi olusturma yontemleri: np.array() (listeden), np.zeros() (sifir dizi), np.ones() (bir dizi), np.arange() (aralikli), np.linspace() (esit aralikli), np.random.rand() (rastgele). Her biri farkli senaryolarda kullanilir.
Matris, 2 boyutlu dizidir ve yapay zekada verilerin temel temsil bicimidir. Goruntu verisi matris olarak saklanir (piksel degerleri), veri setleri matris olarak islenir (satirlar = ornekler, sutunlar = ozellikler).
  Somut Örnekler
	Örnek
	Açıklama
	Günlük Hayat Bağlantısı

	1D Dizi
	np.array([10,20,30])
	Vektor

	2D Matris
	np.array([[1,2,3],[4,5,6]])
	Tablo

	Sifir Matris
	np.zeros((3,3))
	3x3 sifir matrisi

	Aralikli
	np.arange(0,10,2) -> [0,2,4,6,8]
	Adimli dizi



  Görseller ve Tablolar
1D vs 2D vs 3D dizi gorseli
Matris temsili (satir-sutun)
NumPy olusturma fonksiyonlari tablosu
  Analoji ve Benzetmeler
  1. 1D dizi = Tren vagonu: tek sira
  2. 2D matris = Excel tablosu: satir ve sutun
  3. shape = Kutunun boyutlari: en x boy
  4. NumPy = Sanayi robotu: hizli ve tekrarli islemler
  Öğrenci Soru-Cevap
NumPy dizisi neden Python listesinden hizli? - C ile yazilmis, vektorize islemler yapar, homojen veri saklar.
shape ne gosterir? - Dizinin boyutlarini (kac satir, kac sutun).
Matris nerede kullanilir? - Goruntu isleme, veri setleri, lineer cebir, yapay sinir aglari.
________________________________________________________________________________
	  E4  |  DERİNLEŞTİRME (ELABORATE)  —  Transfer & Pekiştirme



  Süre: 10 dakika
  Uygulama Etkinliği: "Dizi ve Matris Islemleri"
Türü: Bireysel Uygulama
Amacı: NumPy dizileri uzerinde matematiksel islemler yapmak.
  Yönerge Adımları
  1. Iki diziyi toplayin, cikartin, carpin.
  2. Matris carpimi yapin (np.dot veya @).
  3. Dizi istatistikleri: np.mean(), np.sum(), np.max(), np.min().
  4. Dizi yeniden seklilendirme: reshape().
  5. Dizi dilimleme (slicing): arr[0:3], arr[:,1].
Beklenen Ürün: NumPy Islem Defteri
  Transfer Soruları
  1. Lineer cebir yapay zekada nasil kullanilir?
  2. Goruntu verisi neden matris olarak saklanir?
  3. Tensor nedir ve NumPy ile iliskisi?
İlişkili Disiplinler: Lineer Cebir, Istatistik, Bilgisayar Bilimi
  Gerçek Yaşam Problemi
	Iki matrisi carpmaaya calisiyorsunuz ama 'shapes not aligned' hatasi aliiyorsunuz. Neden?

Cozum: Matris carpiminda ilk matrisin sutun sayisi, ikinci matrisin satir sayisina esit olmali. Boyutlari shape ile kontrol edin.



Yaratıcı Görev: 5 farkli NumPy dizi olusturma yontemini ve 5 farkli islem ornegini iceren bir referans karti hazirlayin.
________________________________________________________________________________
	  E5  |  DEĞERLENDİRME (EVALUATE)  —  Öğrenmeyi Ölçme



  Süre: 8 dakika
  Öz Değerlendirme Kontrol Listesi
  ☐  NumPy ile 1D ve 2D dizi olusturabiliyorum.
  ☐  Dizi uzerinde matematiksel islemler yapabiliyorum.
  ☐  shape ve dtype kavramlarini anliyorum.
  ☐  Matris carpimi yapabiliyorum.
  ☐  Dizi dilimleme yapabiliyorum.
  Öz Değerlendirme Soruları
  1. NumPy temel fonksiyonlarini biliiyor muyum?
  2. Dizi ve matris farkini anliiyor muyum?
  3. Hata mesajlarini yorumlayabiliiyor muyum?
  Biçimlendirici Değerlendirme (Kısa Quiz)
	No
	Soru
	Cevap

	1
	np.zeros((2,3)) ne olusturur?
	2x3 sifir matrisi

	2
	arr.shape ne gosterir?
	Dizinin boyut bilgisi

	3
	np.arange(0,5) ne uretir?
	[0,1,2,3,4]

	4
	Matris carpimi icin hangi fonksiyon?
	np.dot() veya @

	5
	NumPy neden hizli?
	C ile yazilmis, vektorize islem yapar



  Tartışma Soruları
Açık Uçlu:
  1. NumPy olmadan yapay zeka gelistirilebilir mi?
  2. Matris islemleri gunluk hayatta nerede karsimiza cikar?
  3. NumPy ile neler yapilabiilir?
Eleştirel Düşünme:
  1. Buyuk verilerde NumPy yeterli mi?
  2. GPU hesaplama NumPy yi nasil etkiler?
  3. Matris islemleri sezgisel mi?
________________________________________________________________________________


	  UYGULAMALAR  |  Hands-On Uygulama Etkinlikleri



  Adım Adım Uygulama: "NumPy Dizi ve Matris Uygulamasi"
Hedef: Dizi ve matris olusturmak ve islemler yapmak.
	Adım
	İşlem
	Beklenen Sonuç

	1. 1D Dizi
	np.array ile tek boyutlu dizi olusturun
	Temel dizi

	2. 2D Matris
	np.array ile matris olusturun
	Tablo yapisi

	3. Ozel Dizi
	zeros, ones, arange kullanin
	Hazir fonksiyonlar

	4. Islemler
	Toplama, carpma, istatistik
	Matematiksel islem

	5. Dilimleme
	Dizi parcalarini secin
	Veri erisimi



Tamamlanma Kriteri: En az 5 farkli dizi/matris olusturulmus ve 3 farkli islem yapilmis.
________________________________________________________________________________
  Canlı Demo: "Canli NumPy Gosterisi"
Eğitmenin Gösterdiği: NumPy ile dizi/matris islemlerini canli gosterir.
Öğrencinin Tekrarladığı: Kendi NumPy kodunu yazar.
Dikkat Noktaları: Matris boyutlarina dikkat edin!
________________________________________________________________________________
  Pratik Alıştırmalar
	No
	Zorluk
	Görev

	1
	Baslangic
	3 farkli yontemle dizi olusturun

	2
	Orta
	2 matrisi toplayin ve carpin

	3
	Ileri
	5x5 rastgele matris olusturup istatistiklerini hesaplaayin



________________________________________________________________________________
  Vaka Çalışması: "Boyut Uyumsuzlugu"
	Ogrenci 3x2 ve 4x3 matrisleri carpmaaya calisiyor. 'shapes not aligned' hatasi aliyor. Neden ve cozum?



Beklenen Çıktı: Matris carpim kurali: (m x n) @ (n x p) = (m x p). Ilk matrisin sutun sayisi = ikinci matrisin satir sayisi olmali.
________________________________________________________________________________


	  DERS SONU  |  Özet, Kapanış ve Köprü



  Özet
NumPy ile 1D diziler, 2D matrisler olusturduk ve matematiksel islemler, dilimleme ve istatistik fonksiyonlarini uyguladik.
  Anahtar Kavramlar
	  ndarray
	  1D Array

	  2D Array
	  shape

	  dtype
	  np.zeros

	  np.ones
	  np.arange

	  np.dot
	  reshape

	  slicing
	



  Bir Sonraki Dersle Köprü
NumPy temellerini ogrendik; bir sonraki derste sayi oruntuleri olusturma ve veri dosyalarina geciyoruz.
  Ev Ödevi / Hazırlık
	Gorev: 10 farkli NumPy islemi iceren bir Python scripti yazin.
Teslim: Sonraki ders.
Kriter: Dizi olusturma, islem, istatistik ve dilimleme orneklerinin hepsini icermeli.



________________________________________________________________________________
	  NOTLAR  |  Öğretmen Notları



  Dersten Önce Yapılacaklar
NumPy cheat sheet basilari dagiitin.
Ornek kodlari onceden hazirlaayin.
Projeksiyon ile canli kodlama yapin.
  Olası Zorluklar ve Çözümler
	Zorluk
	Çözüm

	Matris boyutu kavrami zor
	Gorsel matris cizimleri ile destekleyin

	Dilimleme (slicing) kafa karistirici
	Adim adim orneklerle gosterin

	Hata mesajlari anlasilmiyor
	Hata mesajlarini Turkce aciklaayin



Zaman Yönetimi: Teori %25, Uygulama %75.
  Alternatif Plan (B Planı)
	NumPy kurulamamissa Python listeleri ile temel dizi islemlerini gosterin.





